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The Basics
Before we get into a hands-on tutorial, let’s look at an over- simplified DecisionPad example for
a landscape architect to choose between welded garden art vendors to partner with:

The Matrix Tab is your primary interface with a DecisionPad project.
�

Alternatives – the vendors like Gates by Sally to be ranked – are the columns

�

Criteria – the factors we want to evaluate these vendors with – are the rows, in this case
Dependability, Quality and Local

�

Weights set how important each criterion is to the architect

�

Value Cells like High or Yes. These are usually a mix of objective and subjective
values: objective facts like whether the vendor is Local, or subjective evaluations like
Quality of artwork

�

Scales set how valuable each attribute is, thus how to score the apples-and-oranges
inevitable in most real decisions onto a common 0 to 10 scale

�

Ranks and Scores across the top tell you the rank order of the alternatives and how
different their scores are (and shows the change resulting from the latest edit)

�

Outline Object Tree on the left is useful when editing

�

Evaluators – adds a third dimension so organizations or individuals can explicitly show
their needs and opinions (not shown above)

Behind the Matrix view tab are several analysis Report Tabs providing documentation like Notes
or graphical displays like Scores.
DecisionPad helps organizations get decisions made because it draws the relevant issues out
into the open within an intuitive framework that is easy for everyone to understand. The ability to
experiment with assumptions provides transparency and builds credibility. By encouraging
involvement it avoids the frustration of decisions that come unraveled during implementation
due to lack of buy-in or incomplete information. The clarity of the presentation helps people
converge on a conclusion efficiently.
This tutorial is going to construct the decision shown above from scratch. Let’s get going!
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Start DecisionPad. (When there is something for you to do, the verb will be bold.)
Depending on your licensing status you may get a login dialog. If you haven’t yet purchased
your license, please select “Continue as Demo.” If you have a software license serial number
starting with “DP4“ but have not entered it before, do so now to enable the software. See the
Installation Guide for more on these options.
Once logged in select a “New Blank Decision” in the Welcome screen to get this screen:

Note: after about 15 minutes of making changes to a
decision project you will get the Auto-Save dialog:

Since we cannot predict when this will happen we bring it up here. You
can elect to save the file or wait.
The tutorial does not require you to save – your choice.

Consider the outline object tree to the left of the main DecisionPad screen above. Alternatives
and Criteria are the first folders, both now empty. The Views folder has the same items as the
tabs across the top to the right. Scales lists the scales already built into DecisionPad, and you
can create your own when you add Criteria.
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Double-click the Add under Alternatives in the object tree to get the dialog for setting up your
alternatives, the things you’re choosing among.

The Name is the only thing required to set up an alternative.
The Alias is helpful when you wish to publish anonymous reports. The Alias is a randomly
assigned value, guaranteed to be unique, that can stand in for the descriptive name. For
example, you can create a report to show to the vendors (alternatives), so they can see how
they ranked in the decision-making process without revealing who their competition was.
Notes are optional comments on each alternative that can be displayed in various reports. The
bold, italic, etc settings apply to the notes, not the name.
Let’s imagine we are ranking these garden art vendors on their performance this year. Type
“Fred’s Iron Works” as the first alternative name:
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Click OK and your matrix will look like this:

Following the same process listed above, add a couple more alternatives, “Gates by Sally” and
“Welders Anonymous“.

Observe that all three alternatives are ranked “NR”, which stands for “Not Ranked”, because
there are no criteria and data yet to distinguish them. The scores for each one range from 0.0
to 10.0, as the lack of information means every score from lowest to highest is possible. These
ranges will narrow as we add criteria and cell values.
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Next we need some criteria with which to evaluate the alternatives. On the object tree to the
left, under Criteria, double-click Add:

Type “Dependability” in the Name input field.
Criteria require a scale selection. Scales convert the evaluation words into a score from 0 to 10.
This allows DecisionPad to make comparisons and rankings based on a mix of objective and
subjective evaluations which many decisions require, such as “$100” on one criterion versus
“Excellent” on another.
If you pull down the scale list in the dialog you see the built-in scales:

For dependability we might use Excellence or High-to-Low, or create our own with the pencil
point button to insert. For this tutorial select 2: Excellence-5 levels. The dialog will show the
word values for this scale and its scoring between 0 and 10:

Try the Scales and Scoring tutorial later for more on how these work. Click OK to return to the
Matrix view.
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The Dependability criterion appears with question marks for each alternative. Each grid cell has
a pull-down list with the options available for that cell. Click Fred’s Dependability cell, then pull
down the list for Fred’s by clicking on the arrow at the right end of the cell.

Select Good for Fred’s and Excellent for Sally. Leave Welders a ?.

Also change to weight from 0% to 100%. You will need to either hit the Enter key or click the
mouse on another selectable item after you type the 100 to get the matrix to update. You can
type the weights with or without the % sign:

In the score row for Fred’s you see 7.5, which is the scale’s score value for Good and for Sally
10.0, the scale’s score value for Excellent. Because Welders remains a ? it still shows a
possible score range of 0.0-10.0. Fred’s and Sally are now ranked 2 and 1 since they have
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evaluations, but Welders is still NR (Not Ranked) because it has no data at all. As you will see
shortly it is not necessary to have all the cells filled in, just enough ratings to narrow the score
range for meaningful comparisons.
Add two more criteria the same way we did before, by double-clicking on Add under Criteria in
the object tree on the left. Add “Quality” with the 6: High-to-None (High Best) scale, and “Local”
with the 4:Yes/No (Yes best) scale.
Set the weights from 100-0-0 to 40-30-30. You will find that if you change the 100 to 40,
DecisionPad will make sure the total stays 100% and that Quality and Local stay equal so it
changes them each from 0 to 30.
Fill in all but two of the value cells like this:

We now have enough information for all of the vendors to be ranked even though two of them
still have question marks and a range of scores. How did it do this? DecisionPad used the
middle of the score ranges for the ranking as an approximation. However the actual ranking will
depend on which part of the score range turns out to be true. In order to better understand the
situation we need some graphical help.
Select the Scores report tab:

If your scores do not look like this, go back to the Matrix view and check that the criteria have
the right scales and values.
The single score for Fred’s is shown along with the ranges for the other two. You can see how
the middle of the score ranges puts them in rank order 3-2-1. You can also see that no matter
what the question marks turn into, Fred’s is not in the running while either Sally or Welders
could come out best.
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In a real-world DecisionPad with several more alternatives and one or two dozen criteria, it can
be very useful to see how the decision is shaping up. It can save time in gathering data, as if an
option is not going to win no matter what, there is no need to fill in all its values. It can also be
useful when discussions are bogged down over a controversial value – make it a question mark
(?) for a moment to see if its setting would actually affect the outcome.
In this example, return to the Matrix tab and set Welders to Yes for Local:

Select the Scores report:

Now it is clear that Welders is the best even though we still have a question mark unresolved,
so it’s not worth finding out if Gates by Sally is local or not. This feature has proven to be a big
time-saver when the winner is clear and the question mark is difficult like reference checks or
extensive testing.
Let’s see what happens when we increase the weight – importance – of one of the criteria.
Return to the Matrix view, set the weight for Dependability from 40% to 60%.

Weights determine how much importance each criteria carries, so by making this change you
make Dependability three times as important as Quality and three times as important as Local.
The ranking shifts because the mid-point of Sally’ score range is higher than Welders’ score.
Select the Score report which should look like this now:

With this set of weights, Sally could be first or second depending on how the question mark
turns out. We would need that item resolved to make a final recommendation.
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It is often faster and more satisfactory to set weights or subjective values in a graphical fashion.
Switch back to the Matrix view. From the menus across the very top, select the Edit menu and
then the Weights Slider Set menu item:

Try dragging the sliders

with your mouse and clicking the Sort buttons.

Adjusting and sorting is the way most people get to a weight profile that reflects how important
the criteria are. It can be especially effective in a meeting. For example we moved the sliders
and clicked the Sort Hi->Lo button to get to here:

We could use these weights as they are by clicking OK, or we might decide to tidy up the
numbers manually now that we have the basic relationship correct graphically. To manually set
to round numbers click the Manual button in the upper-left corner.
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In order to accept the weights they still must add to 100% but we have decoupled them so you
can set the numbers independently. Type 60 in for Quality (the % sign is optional) and press
Enter. Now the total reads:

You are 2% over. A logical place to remove it is from the 17% by typing 15 and Enter. You
can either click back Auto to verify the changes retained the essential relations or simply click
OK to return to the main screen where the Matrix will show the new weights and their effect on
the decision, if any. The “Previous Rank” and “Previous Score” shows you the impact of your
change on the results.

You can also present the weights as a graph. Select the Weights report tab:

That covers the basics. You will find essentially what we’ve done here saved for your
convenience as Tutorial-1.dp4 in your Samples folder.

DecisionPad 4 Tutorial Guide – 4/9/11 – © 2009-11 Apian Software Inc – Page 13 of 66

Handy Tips and Notes ♪
This chapter introduces a variety of helpful features of DecisionPad. To give us something to
refer to, open the file Tutorial-2.dp4 in your Samples folder. If you used the default installation
path, samples will be under Program Files\Apian Software\DecisionPad 40\Samples or Program
Files (x86)\....
Logo:
The logo you have been seeing in the reports, like the Notes Report shown on p. 16, is shared
by all reports in a decision project. We attached a stock one as a placeholder but a different
image file can be selected through the Project, Logo menu item:

You can browse to select a logo file from your computer, or simply copy/paste in a logo file, to
set your own image.
controls the title, footer and whether
The Views, View Properties menu or its toolbar button
to show the logo image for a view. Each view starts out with default text and logo placeholders
which you can change at your convenience. To change the logo for any report or the matrix,
first go to that tab in the main screen, such as Scores. Then select the Views, View Properties
menu, and the Layout tab to experiment with the setup.
The Matrix view will print with a title, header, footer and/or logo if you include them, but it does
not preview them on screen like report views do.
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Notes:
Notes are explanatory information that can be attached to the overall decision, criteria,
alternatives, and even individual cell values. Attaching notes helps make your decision clearer
to others, whether for decision formulation, approval, buy-in or documentation. Select the
Matrix view tab:

The ♪ markers indicate where notes have been attached. In this example, they appear before
the alternative names and the “Hard” value in the “Ease of Use” row. Hover the mouse over
one and the note pops up. Right-click on one of them, select the Edit option, and you can see
how they were entered, or create your own note.
The Overall Notes are defined using the menu Project, Overall Notes. Select it to see how. You
can choose which part of your overall decision the note will apply to:

Select the Notes Report tab to see how the notes can be used to document the decision – see
next page.
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The Views, View Properties menu lets you control which notes appear in your Notes report. To
access it, click on the Notes Report tab. Then select Views, View Properties, and the Layout
tab. Under “Notes” are checkboxes to include each of the different categories of notes.
Units:
Showing units on numbers makes it easier for viewers of the Matrix to understand what
numbers mean. Return to the Matrix view tab. Look at the definitions for the $, ¢, CPP and
PPM scales to see how the symbols were added. One way to get to a scale is to double-click
on the criterion and click on the middle portion of the pencil to open its scale definition dialog.
Another way is to double-click on the scale in the Outline Object Tree view.
Whichever way you get to the scale dialog, switch to the Numbers tab to view the Symbol or
units selection at the bottom:. Here they are for the three scales in this sample file:

Characters not on your keyboard like the ¢ can be set with the Windows System Tool called
Character Map. The symbols can include leading or trailing spaces like ¢ and ppm.
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Object Tree Outline:
Return to the Matrix view by closing the scale dialog and clicking the Matrix tab or its entry in
the Object Tree.
The Tree view on the left gives you information that may be helpful when the Matrix view is
active. Alternatives, Criteria and Views listed in the Object Tree are all preceded by yellow
boxes. Sharable Scales or Text Styles that are in use are all preceded by green boxes. Scales
or Text Styles that are not yet in use, but which are available for you, are all preceded by empty
dotted squares.
Object Tree items get a blue or red border when they are selected. When something is selected
in the tree itself that item will have a red bordered square and will be the only item selected.
Select the “Poor” cell in the last column to see what happens when a Matrix entry is selected:

All of the items in the tree corresponding to that Matrix cell get blue bordered boxes, so it’s
alternative, criterion, scale and view marker boxes now all have blue borders in the tree. Try
clicking other items in the matrix to see what happens.
When you select a different view tab it will show a blue bordered yellow square for that view in
the tree. If it is a report tab you can make other selections in the tree and edit them, such as
picking an alternative and changing its name which will be reflected in the report. You cannot
select and edit items in the report view itself (you have to switch back to the Matrix view).
When you have a larger decision you can use the tree to bring an off-screen Matrix item into
view – just click on what you want to see in the tree, and DecisionPad will scroll it into view.
If you right-click on an editable item in the tree or matrix you will get a popup menu for editing.
What if the ranking “doesn’t make sense?”:
Sometimes you complete a decision model and the results do not match your intuition. This
could be because intuition is mistaken, but first take a look at the Checklist in the Reference
Guide in case something is set up incorrectly. DecisionPad is intended to help you
communicate so you should be comfortable with how the rankings come out.
Even if everything is set up correctly, the ranking may still come out a way you do not expect.
Consider whether there might be a criteria that’s been left out, that’s influencing your preference
subconsciously but is not yet in the Matrix. Add it and the recommendation may change to
make perfect sense. Since you are going to have to explain and defend your recommendation,
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it’s best to spend some extra time making sure you’re comfortable with the final outcome in the
worksheet.
See the Checklist for the handful of items to review before going public. It’s just like doublechecking the formulas in your spreadsheet before turning in your budget.
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Show-Hide-Sort for Reports and Matrix
Open the file Tutorial-1.dp4 in your Samples folder. If you used the default installation, they will
be under C:\Program Files/Apian Software/DecisionPad4/Samples. The file contains the output
of the Basics tutorial section and should look like this:

Switch to the Scores report tab for this next example:

The scores report provides a nice summary. By default the alternatives are in the as-created
“object tree” order, but you might want to show results sorted by ranking. From the Views
menu, select View Properties or click its toolbar button
Alternatives/Musts/Weights tab.

, and select the
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Change the Sort Rule to By Ranking and Show Alternative Numbers to Yes.

Click OK to see them in ranked order and with the alternatives numbered according to their
column numbers in the original matrix (the numbers to the left of each alternative name):

You can show all of the criteria in a Scores report to give a graphical view of how each
Alternative was scored for each criterion. Select View Properties again from the View menu or
click its toolbar button

and select the Criteria/Scores tab this time:
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It comes up with Show Criterion Total Scores Only checked which gives you the summary result
you’ve been viewing. Click it to uncheck and a criterion selection tree appears:

Click OK to see the graphical view of the scores for each criterion, as well as the overall total:
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We’ve set the order of the alternatives to be by rank. Note that the order for the alternatives is
based on the Total Scores for the whole report; thus the order is consistent across all the criteria
– Welders appears in the first line of each graph because it is in first place overall.
You can control which criteria appear in this report. To show just one criterion and the Totals, go
back to the View Properties and the Criteria/Scores tab.
We’ll change it to showing just Quality and Total Scores. One way is to click the Hide All
button. Click the Quality item and click the Show Node button. Repeat for the Total Scores
item. You should have those items marked with colored squares. When you click OK only
those two items will be in the report.

Return to the Matrix tab. Let’s say you wanted it to be sorted by ranking too. You could do that
by right-clicking on any editable cell to get the popup menu. In the popup menu, hover over
Sorts Alternatives by to show the submenu to the right:
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The alternatives are currently sorted in object Tree Order, which could also be called “unsorted”. Change it to the Rank sort rule.
Remember these sort rules are continuously updated as you make edits so they apply to the
current status of the rankings, not just at the time you request the sort. When you modify the
weights or values enough to change the ranking, the matrix and reports will automatically re-sort
according to your rules. Give it a try.
By selecting Views, New Report you can create additional reports like any of the default views.
The hide and sort rules are set for each view so you can have multiple separate scores reports
showing different aspects of the decision for different audiences. Every report and additional
matrix view (beyond the first one) can have its own hide and sort rules. The built-in matrix view
does not let you hide alternatives or criteria, but if you need a matrix view showing only part of
the criteria or only some of the alternatives you can create an additional matrix. More
information on this is available in the Reference Guide.
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Sensitivity Tests
DecisionPad helps organizations zero in on a well-supported solution with its sensitivity analysis
tools. One such tool is the display of score ranges when there are unknowns, which was
covered in The Basics on p. 11. It showed how sensitive the ranking result was to incomplete
data.
This tutorial covers two other tools:
�

Cell Value Impacts show the cells with the largest individual effect on the ranking

�

Weight Sensitivity report displays how the ranking varies over a range of weights

Sensitivity tests help avoid wasting time on items which may be controversial or difficult to
evaluate but do not actually affect the outcome very much. These tools are especially handy as
the number of alternatives and criteria grow, or as the number of people with opinions grows.
First let’s explore the cell impacts. Open the Tutorial-2.dp4 in your Samples folder and select
the Matrix view tab.
Select the menu Views, View Properties or click its toolbar button
. Select the Layout tab
and select Arrows for highest in the Show Impacts pulldown list, then click OK:

A new column has appeared next to each value setting, displaying impact arrows.

The cells with the largest impact on the ranking are marked with the arrows for this combination
of weights and values, four in this case. Of course those four cells are not the whole story since
the ranking is based on all 21 cells. Often a number of modest impact cells play a bigger role in
the overall ranking as they do here. Four Lasers has a red “negative impact” arrow for price and
15 Individual Inkjets has a green “positive impact” arrow for its low price. Despite this, Four
Lasers are best because of its overall better performance. The arrows are just suggestions of
points of interest that by themselves have a more powerful effect on the rankings.
“Impact” on the ranking is determined by the combination of
�

the weight for the criterion (its importance) and
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�

the difference in a cell value’s score from the average score within each criterion

Thus a heavily weighted criterion will tend to have more impact but only if the values within that
criterion also have significant differences between alternatives. If all the values are the same
like Duplex Printing above, it does not matter how big its weight is – the decision does not
change. Try changing the Duplex Printing weight from 9% to 30% and note that the rankings
stay the same even though the scores shift (you will have to leave the weight cell with the
mouse or enter key before the totals are updated).
Return the Duplex Printing weight to 9% using Undo (edit menu or toolbar

).

Now reduce the weight on Retail Price from 21% to 10%:

The ranking shifts so the Central Laser is the best, primarily due to the Four Lasers’ Cost-perPage, and the balance of other factors making the Central Laser better than the 15 small
printers. Note we now have two large arrows and four smaller ones. Arrow size distinguishes
the strongest impacts from moderate impact cells.
How are the highest impact arrows selected? DecisionPad computes how much each weighted
scored cell adds or subtracts from the overall score. It then looks at the distribution of these
impacts and identifies cells at the outer ends for potential arrows using the Standard Deviation.
When the cell impacts are well spread, about 1/3 will show up as arrows. If they are not well
spread then fewer or even zero cells will be marked. Again, the arrows are only items of
potential interest for discussion, not certain make-or-break items
So far we have been showing the most significant effects with the arrows. You can see all the
effects instead by returning to the View Properties dialog and selecting the Bars for all option:
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Now each cell has a bar graph spark showing its impact:
a moderate positive impact
no impact
a large negative impact
“Sparks” are tiny graphs which can make it easier to understand data than a table of pure
numbers. This option has the advantage of making all the cell impacts visible, big and small, but
it is visually busier. Which one (or both) is more useful depends on your audience..
Weight Sensitivity Report:
Another way to look at ranking sensitivity is to vary the weights and see how the ranking
changes. You can do this yourself manually in the Matrix view. Or, DecisionPad systematically
varies each weight and displays the results in the Weight Sensitivity report. Select the Weight
Sensitivity tab. This report includes all criteria, displayed like this one:

Your screen may be different in detail here because it depends on the cumulative weight
changes you have made so far during this tutorial.
The colored line spark graph shows how the rankings shift around when the weight is varied
from 0 to 100% for 12.5% steps. The vertical line marked “At” is at the current worksheet
setting and the lines cross when the change in the criterion’s weight causes a ranking shift.
The Rank shifts in the table show how the rankings change as the weights are varied from 0 to
100%. The table has more resolution than the spark graphs – it shows each weight setting that
causes a change in the rankings. It is much the same info as the sparks -- displayed
numerically so it’s more detailed, but not as easy to scan.

DecisionPad 4 Tutorial Guide – 4/9/11 – © 2009-11 Apian Software Inc – Page 26 of 66

These are changes to one criterion at a time; the rest of the relative importance relationships
are maintained. If the rest of the relationships change then so will the sensitivity to any one
criterion, thus it is just one way to assess which weights really matter.
In the example the change in rank of Four Lasers from 1 to 2 happens as the weight drops to
16%. Once everyone agrees the weight is above this, then it is not worth much time debating
the exact weight. With Maintenance Fees the weight must jump from 11 to 26% to shift #1:

At the end of the Weight Sensitivity report the scaled score ranges of the values are given for
each criterion:

The bar widths shows how much the values entered differ in their scores. This lets you verify
that your scales reflect how valuable the differences in the answers are. When there is little
difference in the performance between the alternatives for a particular criterion there should be
a small score range. Big perceived differences in utility should have a big score range. When
all the alternatives have the same value the score range will be zero like Duplex Printing here.
This is particularly important to check when using number or date scales to make sure the scale
selection is not blowing a tiny cost difference up out of proportion or understating the value of a
delivery date difference. See the Scales and Scoring tutorial on p. 32 for more on managing
this.
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Criteria Groups
As the number of criteria grow it is useful to group them in one or more outline-like levels. It
helps organize the criteria into logical blocks to aid in understanding the decision. It also allows
setting the weights – importance – on the major groups separately from the details inside each
group.
There are many individual differences about how people deal with decisions, but one thing
seems to be hardwired: humans handle comparisons of up to seven items at one time
comfortably (actually 7 plus-or-minus 2). More than that and they lose track. Thus if you have
two dozen criteria they are best treated in 7 or fewer groups with 7 or fewer criteria in each.
Even large numbers of criteria can quickly be cut into manageable chunks this way.
To setup some groups open the Tutorial-2.dp4 file. This is typical of the results of a
brainstorming session criteria to identify relevant criteria which now need to be organized:

Let’s cluster them into three groups: Financial, Features and Support. The easiest way to
make this transition is to work in the object tree view rather than the matrix since it shows an
outline view and has outline editing menu support:

Right-click your mouse on Retail Price in the tree, select Insert Group from the popup menu
and name the group Finance. Click OK:
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Now we have the group but without members because all the criteria remain at the top level.
Leaving a criterion outside groups can be useful when that single criterion is as important as the
any of the groups and thus merits standing at the top level. However here we want to move
some criteria into our new group.
There are several ways to do this. First try drag-and-drop the Retail Price criteria onto the Add
to Group label:

The tree now shows Retail Price inside the Finance group as Criteria 1.1, and also shows it as a
sub-item in the matrix view.
Right-click Financing Plans and note there is a Move Up item with a control-u shortcut key:

Either select Move Up or close the popup and use the control key with u to put the Financing
Plans criterion into the Finance group:
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Now move Cost-per-page and Maintenance Fees into the group using any method you like.
Insert another group above Print Speed called “Features” and move Speed and Duplex into it.
Insert another group above Ease of Use called “Support and Human Factors” and move Ease
of Use into it. Now the decision should look like this:

Next let’s set some non-zero weights so our matrix computes a ranking. In the matrix, right click
on one of the criteria in the Finance group and pick the Weights Slider Set:
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Set the sliders for some weights; no need to match the profile exactly for this tutorial. Click OK.

Repeat for the top level by right-clicking the Finance group’s row, and either use the sliders
again or just type some numbers into the zeros for a matrix kind of like this:

When you change the Ease of Use weight it will accept 0% but any other number turns into
100%.
To add a new criterion to the last group, double-click Add to Group under 3.1 in the tree and
give it a name like “Convenience” and give it a scale as usual.
Select the Weights report view tab. You will have weight graphs for each group and for the top
level.
That ends the structured tutorial, but you may want to experiment a little more with the Matrix
and reports to get comfortable with how groups operate.
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Scale Definition and Scores
The underlying mathematics of DecisionPad are conceptually straightforward, although the
many details and presentations handled by the program would be tricky hard work if you tried to
program them into a spreadsheet. While DecisionPad handles the details for you, a general
understanding of how the scoring and weighting work will be helpful in structuring your
decisions.
DecisionPad uses a weighted average evaluation – the fancy term is “multivariate weighted
utility analysis” – which parallels the way our minds work well enough to be a successful intuitive
framework.
You lived (and probably suffered at times) with a weighted average scoring method when you
were in school. Your future was determined by a system called your Grade Point Average. The
GPA was the way that accomplishment in French, History, Tennis and Algebra were put on
common ground, just like DecisionPad puts everything on a common scoring system.
So let’s turn DecisionPad into a “GPA computer”. The parallels are:
�

Grade Points are 4.0 for A, 3.0 for B, etc defined as a Keyword Scale

�

Classes taken are the Criteria

�

Units assigned to each class set their importance, so they are Weights

�

People getting graded are the Alternatives

Incidentally, this GPA computer is hardly a trivial example. Although most decision models use
a variety of scales to fit apples-and-oranges criteria, a GPA-like scoring concept may be
mandated in industrial and government RFP evaluations, performance audit check lists, product
comparisons or merit pay ratings. DecisionPad automates these weighted score evaluation
systems nicely, with flexibility in scoring ranges or points to match what your organization is
used to, plus new insight from graphics and what-if analysis.
To build a GPA computer select a New Blank Decision from the startup or File menu.
Select the Project, Scoring menu and set the Scoring range to 0 to 4 as shown below instead of
the default 0 to 10. Select Numeric weights instead of percentages and confirm weights
balloting will not be required:

Click OK.
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Double-click on Add in the criteria tree section, type English into the name:

Click the scale insert pencil point button which brings up the scale definition dialog:

Name the scale Grades. Select the Keywords tab. Set the first list word = highest score and
use the Add button to fill in the grades (A, B, C, D, and F):

Clicking the Graph button – optional – gets the view at the right, a handy cross-check on the
settings or way to explain them to others.
Click Close, Ok and Ok to accept the scale and criterion.
Now put yourself into the picture by double-clicking alternative Add, type in your name and
click OK. The tree and matrix should look like this:
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Given that we do not know the grade yet, your overall GPA (the score) could be 0 to 4. Give
yourself an ‘A’ for English using the pulldown list.

Your GPA is 4.0. The class ‘weight’ is only 1 unit – set it to 4 units or ‘credits’ and the GPA
stays the same as you would expect. Remember you have to move the cursor out of the edited
weight cell in order for the matrix to be recomputed.
Unfortunately you also took a French class that met early Saturday mornings, not your best time
after Friday night parties. Add a new criterion for French. Select the previously defined Grades
scale from the pull-down menu under Scale. Then set it to 5 units and a grade of ‘C’. The new
GPA is 2.9:

The Previous Scores, before entering the grade, showed the possible range of the GPA as 1.8
to 4.0 pending an unknown 5-unit French grade given a 4-unit A in English. (It is NR for Not
Ranked because of the wide score spread).
That’s all for our GPA computer. Let’s look at some other scale types.
We used a Keyword scale type to define our Grades scale on p. 33 Keywords are like the
builtin Excellence or Agreement scales where words are matched to scores. There are several
other scales types available:
�

Rating

�

Forced Rank

�

Numbers

�

Dates or Times

DecisionPad 4 Tutorial Guide – 4/9/11 – © 2009-11 Apian Software Inc – Page 34 of 66

Ratings are scales like “from -5 to +5” and Forced Ranks are like “rank your top 3 choices”. The
definition dialogs for them look a lot like the Keyword GPA we did above. Dates and Numbers
are set up differently so this tutorial will define some Number scales shortly.
Important Concept: your scoring rules should use as much or as little of the 10-point range as
expresses how different or similar the alternatives are for your purposes, their utility range. The
importance is handled by the weights. Thus for each criterion:
�

Scores = benefit differences between alternatives (utility is the technical term)

�

Weight = importance differences relative to other criteria

The emphasis is on differences – all of the computations are relative which is why you can
change the minimum or maximum scores or use points or percentages to present results in the
format people will be most comfortable with, yet still have the same ranking results.
Number or Date scales offer several ways to specify how the scoring will work. The two built-in
number scales go from 0 to maximum (with “maximum” being equal to the highest value
currently entered into the matrix), either making maximum best or 0 best. The use of minimum
and maximum for number or earliest and latest date scales can be trickier than keywords. The
next exercise explores this around the most common item in decision matrices about buying
things: price.
Let’s build a new DecisionPad to experiment with. Select File, New Blank Decision to clear out
the GPA computer
Use the Alternatives Add to put in three: Cheap, Middle and Luxury.
Select Criterion Add, name it Price and use the built-in Numbers 0-to-Max (0 best) scale. In the
Matrix type in the values 2500, 3500 and 5000 in turn. The commas are optional when you
type new numbers. You will need to leave a value cell with the enter key, tab key or by clicking
in another editable cell before the matrix will be updated. Set the weight to 100% so the scores
compute.

The scores and ranks favor the lowest prices since we said 0 (free) was best.
This is a good handy scale for many purposes in buying equipment as it will make the spread of
scores match the full cost range. Here the 5-point difference between the $2500 and $5000
items is about like the difference between Excellent and Fair in the built-in subjective scale, or
nearly the range between a Yes and No. Remember it’s the difference in scores that matters,
not the fact that the lowest price got a 5.
We generally don’t use all 10 points on “hard data” (like cost or specifications) because people
tend to not use all 10 points for subjective ratings, such as quality, service or skills. Thus the
built-in 0-to-Max for cost often works fine.
Before we investigate the scoring further, let’s customize the scale to add a dollar sign to the
values. In order to customize a built-in scale we start by making a copy. Double-click the
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Price criterion in the tree to get its definition dialog, and then click the scale camera button
to copy the built-in scale. In the scale dialog change the Name to “Cost 0-max (0 best).”
Select the Numbers tab at the top, change Symbol or units from None to Before and type in
the dollar sign:

Click on the Graph button to get the display at the right, a graphical representation of the values
for the scale. Click Close, then Ok twice to get back to the worksheet with the new scale and
dollar signs.

In the score graph above you will see that the scoring line ends at Maximum but shows a
dashed extension below $0. This is because any time the number or date goes outside specific
value limits the score is the same as at the edge. Try this by typing -1000 into one of the
values. It will be scored 10.0 like free would be. Remember to leave the cell with enter, tab or
the mouse so the new setting can take effect. You can highlight the whole entry and just type
the new number without the $ or commas.
Sometimes you are more sensitive to even small cost differences, say when you are buying
many pieces of equipment or large quantities of parts.
Lets see what happens if we enter some prices with smaller ranges: type 2500, 2560 and 2620
into the alternatives.

There is only a 0.5 point scoring difference, which will hardly affect the decision once there are
other criteria in play. This insignificant score range would be appropriate for buying one item.
Not so when you are about to buy 1,000 units. The difference between a bid of $2500 and
$2620 for each one becomes very important – $120,000 important. You probably want to use
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the whole 10 scoring point range for these smaller price differences when they’re magnified by a
large volume. Let’s create a new scale for this.
Double-click the criterion Price in the tree, click the pencil point for a new scale, name it MinMax and select the Numbers scale data type. The Keyword tab is replaced by a Numbers tab.
Select it. Pick Set two end points, set the lowest score to Maximum and highest score to
Minimum and add the $ sign. Now your scale and its graph will look like:

After you click OK’s to get back to the matrix, the score range is 0 to 10 for this price spread
Now let’s try the opposite case – where Min/Max gives a false valuation by over-inflating the
effect on the results. Type 2500, 2501, 2502 into the three alternatives. Decision Pad has
dutifully applied the full 10 scoring points to the $2 difference out of $2500. This probably
overstates the value of the $2 price difference no matter how many you buy - $2 out of $2500 is
very unlikely to be as valuable as the difference between Excellent and Unacceptable when
rating risks, services or features.
Conclusion? Min and Max are certainly handy, but use them with care!
Another drawback of using min-max is that the partial data results will be misleading since their
scores would be pegged to limits that may not be the final sets, if later cell entries have higher
or lower values.
Often a better solution is to either set both end points to cover the explicit range of prices you
expect or to use the ratio option tied to the lowest price or a set price.
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Let’s try a ratio setup here. Double-click the Min-Max scale definition in the tree to edit it,
select the Numbers tab again and change the scoring rule to Set one end and a ratio. Say you
want the lowest price to score best but prices close above the lowest will get “partial credit.” Set
the Multiplier to 1.3. This means that anything up to 30% (.3) above the lowest price will get
some points for price. Anything more than 30% above the lowest price will get zero points for
price. Set these so the tab and the graph look like this:

Click OKs to accept. Our $2 spread now all has scores of 10, much more sensible for the 2
dollar difference.
In a real decision, even an alternative which received a zero score on price (with a price at or
above a 30% premium), might still end up ranked #1 because of a strong performance over its
rivals in other areas such as specifications, quality or support. Decisions are all about tradeoffs.
See the Reference Guide for other features of the scale setups.
If a certain price-point is a “deal-breaker” you should control for that with “must-haves” rather
than overstate the scoring (see the next chapter).
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Must Haves
Sometimes there are minimum requirements for one or more criteria which you may want to
document explicitly instead of just leaving the alternative out. In DecisionPad such
requirements are called “Must Haves”. A must have failure is not the same as having a low
score, it is a complete disqualifier.
Open the Tutorial-2.dp4 in your Samples folder and select the Matrix view tab. Select the
Project, Scoring menu item, and set

Click Ok and the Matrix will have a new column for Must Have. Use the drop-down list of the
cell for Ease of Use in the Must Have column. Set a Must Have threshold of Average and you
get:

The Central Laser does not meet this requirement so it is marked disqualified (DSQ) in the
scores and ranks, with a red X for the specific cell (or cells) which caused the DSQ. This drops
the Central Laser out of contention.
The score still shows because there are times when the score is high enough for other reasons
to make it worth investigating workarounds or negotiating other ways to meet the requirement.
For example reduce the weight of Retail Price to 10% and the central printer scores 6.5 versus
the 15 Individual Inkjets at 5.9 so the ease of use cutoff is worth discussion.
Select the Scores report you can see this graphically:

The Central Laser alternative is plotted in red instead of blue and with DSQ at the right side, but
plots better than the other two by scoring.
What if you have a firm budget you must work within? Set a Must-Have Retail Price of $5000.
This will exclude any alternatives that cost more than $5,000. Watch how two alternatives are
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excluded, and Central Laser now has two X’s marking the items that disqualify it. If you go the
scores you see both of the DSQ options out-score the one left.
Summary: It is very important to distinguish between scoring rules, set by the scale to
represent the usefulness of an entry, from a hard Must Have requirement. These are different
tools.
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Weights Four Ways
Open the file Tutorial-3.dp4 which is a grouped criteria case with the impact arrows turned on:

So far in these tutorials we have worked with weights as percentages. The top level weights
(30%, 33%, 37% here) total 100% and within each group the totals are also 100%.
When you change a weight the others will be adjusted to maintain both the 100% total and the
relative importance of the rest – at least as closely as it can get given the need to round off to
even numbers. The Projects, Scoring dialog has an option for adding fractional digits if you like,
but if you follow the practice of keeping groups less than 10 items the extra “precision” really
does not matter.
There is an exception to the forced 100%: you can also force the weights to be 0% for an entire
group by setting one member at a time to 0.
Although percentages are a natural way to express weights, DecisionPad allows three other
ways to set the weights because they may be more intuitive for some people or fit an existing
business practice: Words, Numbers or Points.
Let’s try it with Words instead of Percents. Select the Projects, Scoring menu and change from
Percentages to High-low weights:

Click OK. Now the matrix looks like this:
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The weights have been converted to words assuming that Very High (V-High) is 3 times Very
Low (V-Low), which is what the default Ratio specifies in the previous dialog, chosen because it
seems to fit people’s intuitions. You are free to use other ratios if you like of course.
When making this change, you lose some precision, but may gain some ease of use for people
to specify weights. Let’s see the actual effect in this case when we made this change.
Comparing the Scores Report for these two cases, percentages left and words right:

Since the weight conversion is an inexact one (only 5 words versus 100% numbers to work
with) the scores have changed a little but the overall rankings are the same. One small impact
arrow also became more significant.
Like the percentages, the word weights at the top grouping level are one set of weights, while
the criteria are independently weighted within each group.
To see this, change Ease of Use from Medium to V- Low. Same exact scores. It is the only
criterion in the group so its high or low weight does not matter because there are no other group
members to compare it to. Its effect on the scores is entirely controlled by its group weight:

If you change the weight of Print Speed from High to Low it makes the relative importance of
that group’s two criteria equal. This changes the top scores because the group score has
changed. If you make both Print Speed and Duplex Printing V-High the overall scores would be
the same because their relative importance is still equal.
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Let’s move on to setting weights by numbers. It will be clearer if we start with a clean copy of
Tutorial-3. Please close your current working version and re-open it from the Samples folder.
It should look like the first page of this section again.
With Project, Scoring change the method to Numeric Weights.

You will get a warning:

Because of the sub-totaling we are about to explore, where criteria weights ripple up through the
parent groupings to the total, the setting of weights in 3D ballots became too complex for
evaluators who are not cannot be expected to know that much about DecisionPad. If you intend
to use the balloting feature then stay with percentage or low-high word weighting. Click OK for
this tutorial and the updated matrix:
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Something new has been added, an explicit total which was set to 1000 by the conversion. If
you look back the percentage version you find that the numbers are just the percents times 10
and the scores are the same as they were. All we have done so far is change the way people
perceive the weights; the math comes up with the same scoring.
What changed is that groups are no longer independent. The weight numbers add bottom-up
through groups to the total weight. However right after this conversion, the weights within a
group have the same relative values as the percentages they came from as in the first Finance
group:
48

16%

69

23%

135

45%

48

16%

Try changing the Print Speed weight to 116 and observe how that changes the group sub-total
and the overall total. Then change the Features group weight back to 330. Remember you will
have to leave the weight cell with the mouse or enter key before the totals are updated:

When you forced the group back to 330 it retained the criteria weighting equality by making
each criteria 165. The grand total is back to 1000 but you have changed the relative importance
of the two criteria – and it is the relative importance that matters. DecisionPad will retain the
proportions inside a group whenever the group’s weight is changed for numeric or point
weighting.
Let’s move on to discussing setting weights by points with a clean copy of Tutorial-3. Please
close your current working version and re-open it from the Samples folder. It should look like
the first page of this section again.
Notice your Scores (at the top of the matrix) before you change it – they are all between zero
and 10.
With Project, Scoring change the setup to Points and confirm that non-ballotable is OK. The
scoring range setting goes away from the dialog because the points will be totaled directly.
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Click OK The Matrix looks almost the same except the 0-10 scores which have become point
totals. The rankings are exactly the same:

Compare it to the Numeric weighting above -- what changed? Mathematically, nothing really,
because all of the computations are relative. Except for round off details, we are just changing
the way people relate to the tradeoffs.
In this case, our Total Points (the old Weights total) is still 1000. The criterion weights became
the possible points for each one.
Say your company already uses a vendor evaluation system that has 250 possible points, the
Point total at the top will be between 0 and 250, since you would set up your matrix to have 250
Total Points on the bottom left. When people are familiar with the old point values, like “over
210 points is really good”, using the same points makes acceptance of the DecisionPad version
more comfortable than switching to scores would be.
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If you play around with the criteria points and end up with a strange number of total points, you
can always come back to the bottom left, change the total point value to 250, and your Point
calculations will fit the company point system again. Or force the total in the Weight Slider
screen.
Another way of looking at it is that with numeric weights DecisionPad normalized the weighted
totals back to scores, while here it left them totaled as points A score of 6.7 out of 10 becomes
a point total of 668 out of 1000 or 167 out of 250. But it’s all relative; the rankings work out the
same.
One other difference you will see with points is in the scale setups:

On the left the values are tied to scores for Numeric or Word weights; on the right it is the
percentage applied to each criterion’s points.
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Multiple Evaluators
The basic DecisionPad matrix is 2-dimensional – alternatives versus criteria – but a third
dimension of evaluators can be added to explicitly represent different requirements for the
decision. More than one evaluator can be specified, each adding a layer to the decision matrix.
DecisionPad computes a Summary layer which “averages” out the differences between
evaluators. This way each evaluator’s viewpoint remains visible as if the decision was theirs
alone, so everyone can clearly see where the differences lie to chose a workable compromise
alternative – or perhaps synthesize a new alternative which is better for everyone.
To try this out, open the sample file Tutorial-4.dp4:

Select Project->Users-Evaluators which looks like this initially:

The Administrator selection would allow you to password protect yourself, as the decision
administrator, or to password protect and encrypt the DecisionPad .dp4 project file. For this
tutorial leave it on the Evaluators selection.
Click Add New and confirm you want to proceed with Multiple Evaluators. This makes visible
settings for the first evaluator:
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On the right side type the Matrix Name Finance for this tutorial. We will add contact information
in later chapters when we setup ballots or invitations. For now the department name will be
sufficient for this tutorial. It is best to name evaluators by the organization or community they
represent to de-personalize the analysis a bit.
Click Add New to add Marketing, and again to add Legal:

Click OK to return to the main screen:

DecisionPad 4 Tutorial Guide – 4/9/11 – © 2009-11 Apian Software Inc – Page 48 of 66

The criteria are still the rows and the alternatives are the
columns.
A new control area has been added at the lower-left which
switches the matrix view between evaluators. The
evaluators are a stack of screens, sometimes called a “zaxis”. The view starts out on the Summary which is an
average of the evaluator’s opinions.
Pull down the Evaluator list to see them all.
Click the
button to step through them. Watch the matrix
which will show the names and their entries; notice they are all
the same at this point, inherited from the 2D version.
Three new buttons
have appeared in the toolbar
below the menus to switch the matrix between orientations. Try them and you will see that the
lower-left changes to select Criteria or Alternatives as they become the Z-axis.
Go back to the A/C view above.
The criteria are all marked with a , meaning their values are Global and apply to all
evaluators. These are typically used for facts or for items which are specified as fixed
parameters of the decision. In order for the evaluators to express their own opinion, like for
Ease of Use, we must tell DecisionPad that certain items are (i) or for Individual. The weights
are currently also (g) meaning one set applies to everyone.
In order to mark some criteria for individual input, select the Project->Users-Evaluators dialog
and select the Criteria Global/Individual tab:
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The last group has subjective issues which the three departments are likely to rate differently,
like convenience, so mark them Individual:

Switch to Group Weights. The global/individual setting for weight applies to all members within
a group, or to all at the top level. In this example let’s assume that the finance department is
going to set the weights for those finance criteria, but that each department will express their
opinions about importance for the rest. Marketing is likely to care more about color rendition
than Legal.
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Click OK to return to the main screen:

Now you have the symbol for an individual setting on the three criteria and weights are
marked as a mix of global and individual.
Switch to the E/C orientation, the middle selection button:
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You have the evaluators across the top and criteria down the left, showing entries for one
alternative at a time.
Try making changes to the values. You will find:
�

You can make the evaluator settings different for the three
Summary to find an “average” consensus value,

�

Changes to the
the evaluators

criteria which will cause the

criteria can only be made for the summary which then copies into all

Pulldown the Alternatives list and select Weights which is also on this z-axis:

The weights are now a mix of global – the ones within the finance group – and individual for the
rest:
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Experiment with adding weight settings. Again you make changes to (g) group weights in the
Summary column and (i) individual weights in each evaluator’s column.
That completes the setup of multiple evaluators. From here you could gather all the inputs via
meetings or email to fill in the matrix, or you could gather the inputs via balloting on people’s
web browsers as described in the next section.
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Balloting Via the Web
“Balloting” in DecisionPad terminology means the ability
for participants in the decision process to enter their
opinions through a web browser. These opinions are later
merged into the DecisionPad matrix for evaluation. The
browsers could be on laptops in a face-to-face meeting or
they could be spread around the world. Some of the
scenarios where balloting would be used are described in
the Reference Guide.
It generally involves multiple evaluators like we set up in
the previous section. Apian Software offers a cloud server
for secure balloting available to licensed DecisionPad
owners as explained more fully in the Reference and Installation Guides. (Note that the
demonstration version does not have upload access to this balloting server, though you can
experience how these ballots work using a demonstration folder.)
Open the sample file Tutorial-5.dp4.
In order to have evaluators enter their opinions via the web you need to assign login names and
passwords to control access. This sample file is basically the result of the previous tutorial plus
some logins. To see how those were set select Project->Evaluators-Users for the Evaluators
tab:

Pick an evaluator like Finance from the list on the left and click the Edit Login button to see the
login already in the sample file:
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If the sample file did not have logins yet, for example at the end of the last Evaluators tutorial,
then the button would have said New Login. Logins could be set when first creating the
evaluators or deferred until the ballot startup needs them. For the sample we made the user
name the same as the evaluator with one password abcd1234 for all three. In the real world
please set something more secure. Click Cancel twice to close the user setup dialogs.
Once any login passwords are set the DecisionPad .dp4 project file is encrypted. You can
“open” tutorial-4 and tutorial-5 in a plain editor like Notepad to see the difference if curious.
Select the Web->Balloting menu. The first Page Template tab sets a title and has some layout
controls which we will ignore for this tutorial. Select the second Who and What tab:

This is where you identify who is going to participate in this round of balloting, and what items
specifically they are to supply information for. In many cases it will simply be all the individual
items evaluators can enter, which is what we are going to do for this tutorial. But if you were
using DecisionPad in a meeting you might do just a few items at a time, collect the ballots,
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discuss, and then move on to request more. You can ballot as often as you like on whatever
combination suits your needs.
To continue our example, select All Evaluators and check all three Individual items, or in this
case the easiest is to click the 9 Group:

Switch to Weights and click the Set the (i) button to turn them all on too:

Remember that weights are set within a group or at the top level, so when you select the
Features group it means the weights of all criteria within Features are individually settable.
When you make Top Level Weights ballotable, then the three groups at the top become
individually settable, including the Features group itself.
To verify that your settings will do what you want, select the Net Ballots tab to see:

In this case things are pretty straightforward so you should not be surprised, but when your
decision team gets more complex this screen will become handy.
Note: if you are running a demonstration installation of DecisionPad you will be unable to
continue past this point. You can see the resulting ballots in a demonstration folder. Licensed
owners who have arranged for a Balloting Server Folder will be ready to continue.
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Click the Start Balloting button and tell it to Save As a different .dp4 file so the sample is left
alone. After saving it brings up the balloting launch dialog:

Balloting uploads to a DecisionPad subscription folder on the Apian Software cloud server. It
needs to know which server folder you are going to use. To select one click the Browse Server
button:

Identify the subscription folder if it appears and click the Use button. If another project is in
that folder, as shown here, you will need to confirm it is OK to overwrite it. Otherwise selecting
<add folder> lets you specify another folder and password, then click the Verify button which
checks the setting is valid and puts it in the list. Once in the list the Use button will accept it.
For new folders you will be required to replace the temporary password. For more details on
the server folders see the Balloting Web Server Management topic in the Reference Guide or
use the ? help button.
Back in the Start Balloting dialog, the folder assigned will be shown. Leave the rest of the
settings at the defaults for this tutorial.
Click the Start button, wait a few seconds. If all goes well the next thing you see is:
DecisionPad 4 Tutorial Guide – 4/9/11 – © 2009-11 Apian Software Inc – Page 57 of 66

This confirms that the ballots have been uploaded and are waiting for evaluator input. As
evaluators make entries you can refresh this screen to monitor progress, or close out of
DecisionPad and come back in an hour or a day to check. DecisionPad need not be running
while the server is collecting ballot input.
Close the status dialog and minimize DecisionPad. Time to try those ballots out as if you were
one of the evaluators, switching away from your Decision Administrator hat.
Entering a ballot:
Open a browser and type in a URL that looks like
https://decisionpad.com/secure/rentalsC/C001353/
except with your folder number (must be an exact match including all the zeros). You should
get the ballot login dialog:
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Type in one of your evaluator’s logins and click the Log In button. Next you should get:

The screens shown here are for a browser with javascript enabled, which has become normal
given the number of popular sites that take advantage of it. We recommend participants enable
javascript, but in case it is disabled the selection screen above will have buttons for selection,
the weights screen sliders below will be replaced by number entries and note editing will not be
available.
Shown are the items you selected earlier as the decision administrator. Click the Weights
within Support and Human Factors ballot for
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These weights are controlled by the sliders. Drag each of the little grey boxes to the right or left
to set the weights. Remember that weights are relative so numbers do not matter.

Try the sort buttons which help you confirm the criteria are in the right order of importance. It
is most important to get the order of importance right; in most decisions small changes in the
percentages will not affect the results (something the weight sensitivity reports can verify later).

Assuming JavaScript is enabled you can click one of the Note buttons to make a comment:

Click Cancel or Done to close the note edits. Click the Submit & Summary button for the Ballot
list; select one of the Values choices:
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Make some changes and click Submit & Summary for the updated menu:

And so forth.
Now let’s put your decision Administrator hat back on.
Collecting Ballots into DecisionPad:
Reopen the DecisionPad window and select Web->Balloting. Your Administrator’s status
screen should update to show any entries you just made:
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When an evaluator uses Logout (button near the ballot top) or abandons the session, they can
come back any time to continue the entries. When they are sure they are done they click the
Finished Balloting button which notifies the decision administrator that their inputs are complete.
As Administrator, when you Refresh the ballot status window it would show that evaluator has
completed what they intend to though leaving criteria incomplete:

From DecisionPad you have several options for collecting the ballots:
�

Collect and Close –stops the ballot entries, gathers the inputs (finished or not) and
downloads them into your matrix view.

�

Peek – downloads the latest updates to the entries but lets the ballot entry continue

�

Abort – stops the balloting but does not collect the latest information. If you had done a
peek those entries will be kept but anything afterwards would not.

You can try one of these now. For example clicking the Collect and Close button gives:

You can specify a custom message of your own for people who try to access the closed ballots
or just let it say there are none. Click Close Balloting to confirm that is what you want to do:
A few moments later the confirmation appears:

The downloaded entries will be in the right evaluator (pulldown list on the left to select) including
any Notes attached to entries, and the summary will be updated.
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Email Invitations
You can send emails to the participants at any time once you have entered their email
addresses in the Project -> Users-Evaluators dialog. Normally you would start the ballots and
confirm they are ready to go before sending invitations, but you can send email to users in your
project at any time.
Open the sample file Tutorial-6.dp4.
Select the Web -> EMail Invitations menu item for this dialog:

For sample purposes the emails are obviously not real. If you want to send mail from this
tutorial, cancel out and go to the Projects->Evaluators-Users menu to edit the contact
information, then return here.
Click the checkboxes to select the evaluator(s) to be mailed in this batch, and then select the
Message tab:

Enter a From address for your mailing, usually your own email as the decision administrator.
A default draft message has been filled in assuming you want to give people their balloting login
information but you can edit this message to be whatever you like. Or restore it to the Default.
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The items in the {{ }} brackets are variables to be replaced with the values for each recipient.
There are additional variables listed at the upper-right of the dialog. If you wanted to add
something like “The phone we have for you is 555-1212“ you would type in that text up to where
the phone number is to go, leave the cursor there, pull down the list showing <Pick One>, select
the Phone Number item and click Insert in Body. Your Message body would then read “The
phone we have for you is {{Contact Phone}}”.
Notice the At Folder label next to the Browse Server button in the variables section. This is the
balloting server folder for this decision project, and is required for the {{Ballots At}} variable. It
would be set already if we had created ballots and uploaded them, or show as undefined. To
set the folder click Browse Server to identify the one to use.
Emails will be sent through a STMP mail server. This generally needs to be set just once. If it
has not, click the Mail Server button to get the setup dialog:

If the Host URL is filled in then you are probably in business. Otherwise type your server
information if you have it or try 10.0.0.5 which works in many networked environments. You can
click Test which will ask for your email address and sends a short confirmation message to
your own inbox. In case that does not work refer to the Reference Guide for the full details on
how to establish the connection.
Once you have an email server connection return to the mail message tab. Finish editing your
message then click the Test Send button to verify it by sending a copy to yourself. The email
you get will still have the curly bracket variables in it but otherwise will be what your decision
participants will see.
When you are ready to send the batch click Send EMails. This will get a confirmation dialog:

When you click OK the messages will be sent and logged in here.
Like any email send, if the address structure is legal it will be accepted without comment. If the
address does not actually work it will come back later as a bounced email in your regular inbox.
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